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Einleitung
Überblick über MIDI Song to Style

Die MIDI Song to Style App wandelt automatisch MIDI-Songs (SMF: Standard MIDI File, Erweiterung: .mid) in Styles-Dateien 
(.sty) um, sodass Sie die gewünschten Songs als Styles auf dem Instrument spielen können.

Sie können konvertierte Daten folgendermaßen anhören und bearbeiten:
- Durch Abspielen geladener MIDI-Songs und Ändern der Voice-Zuordnungen für jeden Kanal

- Durch Anhören und Bearbeiten konvertierter Styles

Vorsichtsmaßnahmen bei Verwendung der Anwendung

• Diese Anwendung (nachfolgend als „App“ bezeichnet) sammelt anonyme Daten zur Funktionsnutzung, um die Servicequalität 

zu verbessern und für zugehörige Produkte und Services zu werben. Die tatsächlich von Ihnen bearbeiteten Daten werden 
nicht erfasst. Wenn Sie den Nutzungsstatus nicht senden möchten, können Sie dies in den Einstellungen (Seite 13) 

deaktivieren.

• Der Hauptzweck dieser App ist es, MIDI-Songs in Style-Dateien zu konvertieren, sie ist nicht als Audio-Player gedacht. 
Beachten Sie bitte, dass die folgenden Vorschaufunktionen der App nur als Bearbeitungshilfe dienen und die vollständige 

Kompatibilität der Audiowiedergabe usw. nicht garantiert wird.

- Wiedergabe von MIDI-Songs
- Wiedergabe von konvertierten Styles

• Diese App kann nur mit Modellen verwendet werden, die mit dem SFF GE-Format (z. B. Genos2) kompatibel sind.

Computer

Instrument

MIDI Song to Style

MIDI-Song
(.mid)

Style
(.sty)

Übertragung über 
verbundenes USB-
Kabel oder USB-
Flash-Laufwerk
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Einrichtung
Anschlüsse und Einrichtung

Diese App kann auf zwei Arten verwendet werden: entweder durch Anschließen an das Instrument oder einfach als Standalone 
auf einem Computer.

 Verwenden der App durch Verbinden des Computer mit dem Instrument
Diese Methode wird empfohlen, weil Sie auf diese Weise die Änderungen so abspielen können wie sie tatsächlich zu hören sind.

Anschlussbeispiel

Anweisungen zum Anschließen des Computers an das Instrument finden Sie in der zugehörigen Bedienungsanleitung.

Möglichkeiten beim Anschließen an das Instrument:
• Wiedergabe von MIDI-Dateien mit den Sounds des Instruments
• Anhören von konvertierten Styles mit den Sounds des Instruments

• Speichern (übertragen) von konvertierten Style-Dateien direkt auf dem (das) Instrument

• Angeben von Akkorden auf der Tastatur des Instruments, während Sie die konvertierten Styles anhören

Erforderliche Einstellungen:
Öffnen Sie [Preference] -> [MIDI Device] im Menü oben in der App und stellen Sie den Port folgendermaßen ein.

• MIDI Input Device: MIDI Out des Instruments

• MIDI Output Device: MIDI In des Instruments

HINWEIS
Wenn Sie Akkorde vom Instrument angeben, während Sie Daten auf dieser App anhören, müssen Sie darauf achten, dass die 
Schaltfläche [ACMP] am Instrument deaktiviert ist. (Wenn Sie das Instrument mit den geladenen konvertierten Style-Dateien 
verwenden, aktivieren Sie wie gewohnt [ACMP].) 

HINWEIS
Sowohl Ein- als auch Ausgang müssen für das Instrument festgelegt werden, damit die Datenübertragung funktioniert.

Computer

Instrument

Lautsprecher 
oder 

Audioausgang 
des Instruments

USB-KabelMIDI Output Device

MIDI Input Device
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Einrichtung
 Verwenden der App als Standalone mit einem Computer
Sie können die App auch allein verwenden, ohne das Instrument mit dem Computer zu verbinden. Bei dieser Methode brauchen 
Sie nur den Computer, allerdings werden die Voices und Styles dann nicht so genau wiedergegeben.

Anschlussbeispiel

Möglichkeiten, wenn nur ein Computer verwendet wird:
• Wiedergabe von MIDI-Songs mit den Sounds des Softsynth in der Anwendung (*1)

• Anhören von konvertierten Styles mit den Sounds des Softsynth in der Anwendung (*1)
• Speichern der konvertierten Style-Datei auf dem Computer oder Übertragen auf das Instrument mithilfe eines USB-Flash-

Laufwerks

• Angeben von Akkorden auf der Akkordpalette (Seite 14) in der App, während Sie die konvertierten Styles anhören

*1) Die Sounds werden nicht mit der vollen Genauigkeit wiedergegeben.

Erforderliche Einstellungen:
Öffnen Sie [Preference] -> [MIDI Device] im Menü oben in der App und stellen Sie den Port folgendermaßen ein.
• MIDI Input Device: Keine (wählen Sie diese Einstellung, wenn Sie ein MIDI-Keyboard usw. haben)

• MIDI Output Device: MIDI Song to Style Synth sowie ein Audiogerät zum tatsächlichen Spielen von Sound

Internes 
Audiogerät des 

Computers

Computer-
Lautsprecher

Integrierter 
Softsynth

MIDI-Keyboard usw.

Computer

MIDI Output Device

MIDI Input Device
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Einrichtung
 Importieren der Voice-Liste
Wenn Sie die Voices jedes Kanals eines MIDI-Songs ändern, der in diese App geladen wurde (Seite 26), können Sie Voices aus 
der Voice-Liste in der App auswählen. Die Voice-Liste für Genos2-Firmware Version 1.00 ist die ursprüngliche Liste dieser App.

Durch Importieren der Voice-Liste können Sie die Voice-Liste in dieser App mit der des verknüpften Instruments abgleichen.

Für kompatible Produkte sind Informationen zur Voice-Listendatei für MIDI Song to Style auf der Produktseite der Yamaha-
Website (https://www.yamaha.com/) zu finden.

1. Wählen Sie [Edit] -> [Import Voice List] im Menü oben in der App aus.
Ein Fenster zur Dateiauswahl wird geöffnet.

2. Wählen Sie die Voice-Liste (.txt) für Ihr Instrument aus.
Die Voice-Liste in der App wird mit der geladenen Liste aktualisiert.

Wenn keine Fehlermeldung angezeigt wird, wurde der Ladevorgang abgeschlossen.
5



Quick Guide/Überblick
Verwendung von MIDI Song to Style

 Die einfachste Art der Verwendung: Konvertieren und übertragen

1. Ziehen Sie die SMF-Datei in MIDI Song to Style und legen Sie sie dort ab.

Der von Ihnen übertragene MIDI-Song wird automatisch analysiert und in einen Style umgewandelt, sodass Sie den 

konvertierten Style in der App abspielen und bearbeiten können (Seite 17).

2. Übertragen Sie die Ergebnisse der Analyse als Style-Datei auf das Instrument. (Klicken Sie auf .)
Es gibt zwei Übertragungsmöglichkeiten:

A) Speichern Sie die Style-Datei über eine USB-Kabelverbindung direkt auf dem Instrument (Save to Instrument 
(Auf Instrument speichern)).
(Sie können die Datei über ein USB-Kabel auf das Instrument übertragen, wenn der Computer angeschlossen ist. 

Auf Seite 3 finden Sie die notwendigen Einstellungen.) 

B) Speichern Sie die Style-Datei auf einem USB-Flash-Laufwerk und übertragen Sie die Daten dann auf das 
Instrument (Save to Computer (Auf Computer speichern)).

3. Spielen Sie das Instrument mit dem übertragenen Style.

HINWEIS
Anstatt die Ergebnisse der automatischen Analyse zu verwenden, können Sie auch Sections und Parts mittels Meta-Events (Marker 
und Spurnamen) zuweisen, die Sie vorher in den MIDI-Song eingebettet haben.

Beachten Sie das Display für weitere Einstellungen (Seite 13), um die Einstellungen zur Aktivierung dieser Funktion vorzunehmen, und 
die Tabelle (Seite 32) für das Format der Meta-Events, die in den MIDI-Song eingebettet sein sollten.

1 2

Computer

MIDI Song to Style

MIDI-Song
(.mid)

Style
(.sty)

Übertragung über 
verbundenes USB-
Kabel oder USB-
Flash-Laufwerk

Instrument

MIDI-Song-Datei
Standard-MIDI-Dateiformat 
(.mid)
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Quick Guide/Überblick
 Erneute Analyse durch Ändern der Analysebedingungen
Wenn die Ergebnisse der automatischen Style-Umwandlung nicht dem entsprechen, was Sie sich vorgestellt haben, können Sie 
die Analysebedingungen ändern und den geladenen MIDI-Song erneut konvertieren.

• Achten Sie darauf, den Haupt-Melody-Kanal und andere Kanäle auszuschließen, die im Style nicht berücksichtigt werden 

sollen (Seite 20).

 Bearbeiten des automatisch konvertierten Styles
Sie können den automatisch konvertierten Style auf folgende Arten manuell bearbeiten.
• Durch Ändern des als Section aus einem MIDI-Song extrahierten Bereichs (Seite 21) 

• Durch Neuordnen der Sections (Seite 22) 

• Durch Auswählen eines neuen Bereichs und seine Zuordnung zu einer Section (Seite 23) 
• Durch Ändern der MIDI-Kanalzuordnungen jedes Style-Parts für jede Section (Seite 25) 

• Durch Ändern der Voice für jeden Kanal eines MIDI-Songs (Seite 26) 

• Durch Ändern/Zurücksetzen der Lautstärke für jeden Part eines Styles (Seite 27) 
• Durch Ändern des Style-Beats oder des Taktmaßes (Seite 28)
7



Quick Guide/Überblick
Speichern oder Laden der aktuell bearbeiteten Daten (Projekt)

Sie können die geladenen MIDI-Songs, einschließlich analysierter Informationen und bearbeiteter Inhalte, als Projektdatei in 
einem speziellen Dateiformat (.sts) speichern oder laden.

In der Projektdatei wird der folgende Inhalt gespeichert:
• Inhalt des geladenen MIDI-Songs (SMF-Datei)

• Die Ergebnisse der automatischen Analyse eines MIDI-Songs

• Der Style-Bearbeitungsstatus, einschließlich Section- und Part-Zuordnungen

 Speichern eines Projekts
Öffnen Sie [File] -> [Save Project] im Menü oben in der App und geben Sie den Speicherort an.

 Laden eines Projekts
Öffnen Sie [File] -> [Open Project] im Menü oben in der App und wählen Sie die gewünschte Projektdatei aus. Sie können die 

Projektdatei auch einfach ziehen und in der App ablegen.
8



Funktionen (Beschreibung des Displays)
Display-Übergänge

Nachstehend sehen Sie einen groben Überblick über die Display-Übergänge, die nach dem Starten der App angezeigt werden.

Beim Start

MIDI-Einstellungen

Weitere Einstellungen

Home (Easy)

Akkordpalette (separates Fenster)

Home (Edit)

Speichern von Styles

Detaillierte Bearbeitung (separates Fenster)

Bearbeiten von Section-Parametern

Datei laden

Modus wechseln
9



Funktionen (Beschreibung des Displays)
Display-Funktionen

In diesem Abschnitt wird erklärt, welche Bedienvorgänge in jedem Display der obigen Übersicht vorgenommen werden können.

 Home-Display (Easy)

q Steuert die MIDI-Song-Wiedergabe

w Öffnet das Display zum Laden einer neuen Datei

e Wechselt den Home-Displaymodus (Easy  Edit)

r Öffnet das Fenster für MIDI-Einstellungen (Seite 12)

t Öffnet das Fenster für weitere Einstellungen (Seite 13)

y Zum Abspielen von Sections des konvertierten Styles (Seite 17)

u Spielt den angegebenen Akkord während der Style-Wiedergabe und öffnet das Fenster mit der 
Akkordpalette (Seite 14)

i Öffnet das Display „Style Save“ (Seite 19) 

q

t

y

e

r

w

u

i
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Funktionen (Beschreibung des Displays)
 Home-Display (Edit)

Funktionen q bis i sind mit denen des Home-Displays (Easy) identisch.

o Analysiert neu, nachdem die Einstellung für die automatische Analyse geändert wurde (Seite 20).

!0 Prüft und bedient jeden Kanal für die MIDI-Song-Wiedergabe
• Zeigt den groben Typ der Voice an (nur Display)

• Legt die Ein/Aus-Einstellung (Stummschalten) jedes Kanals fest

!1 Zeigt eine Übersicht der MIDI-Song-Daten an und ermöglicht die Bearbeitung der Style Sections
• Zeigt die Datenübersicht jedes Kanals für einen MIDI-Song an (nur Display)
• Zum Bearbeiten der Style Section (Seite 21)

• Zum Ändern die MIDI-Kanalzuordnung für jeden Style-Part (Seite 25)

!2 Zum Einstellen der Vergrößerung der Übersichtsanzeige für MIDI-Song-Daten (!1).

!3 Zum Anzeigen und Ändern verschiedener Style-Einstellungen (Seiten 18, 27).
• Tempo (nur Display)
• Taktmaß (Beat)

• Ein/Aus und Lautstärke für jeden Style-Part

• Tonart der Section

!3

u

!1

!2

t

y

r

e

!0

qo wi
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Funktionen (Beschreibung des Displays)
 Display für MIDI-Einstellungen

q Legt das MIDI Input Device fest

w Legt das MIDI Output Device fest
Wenn Sie „MIDI Song to Style Synth“ auswählen, müssen Sie auch das Audio-Ausgabeziel festlegen.

e Aktualisiert die Liste der MIDI-Geräte

w

q

e
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Funktionen (Beschreibung des Displays)
 Display für andere Einstellungen

q Legt die maximale Größe für konvertierte Style-Dateien fest

w Bestimmt, ob das Fenster mit der Akkordpalette (Seite 14) automatisch aufgerufen wird, wenn 
ein Style wiedergegeben wird

e Legt fest, wie die in den MIDI-Song eingebetteten Informationen gehandhabt werden.
Es gibt zwei Einträge.

• Wählen Sie eine der folgenden Informationen aus, die oben im Home-Display (Edit) angezeigt werden sollen.
- None: Es wird nichts angezeigt.

- Marker: Es wird der Text des Meta-Events (Marker) angezeigt.

- Beat: Es wird der Beat (das Taktmaß) angezeigt.
- Tempo: Es wird das Tempo angezeigt.

- Chord (XF): Es wird der Akkord angezeigt.

• Aktivieren/Deaktivieren Sie die Funktion, mit der Meta-Events im MIDI-Song für die Zuweisung von Sections und 
Parts verwendet werden können.
Wenn Sie diese Funktion nutzen, werden Sections und Parts nur mittels der eingebetteten Meta-Events zugewiesen, ohne 
dass die Ergebnisse der automatischen Analyse verwendet werden. Das bedeutet, dass Sie sie wie angegeben zuweisen 

können, wenn die Informationen vorher in den MIDI-Song eingebettet wurden.

Marker werden verwendet, um Sections zuzuweisen, und Spurnamen werden verwendet, um Style-Parts zuzuweisen.
Welche Strings (Zeichenketten) für die Zuweisung von Sections und Parts erforderlich sind, finden Sie in der Tabelle auf 

Seite 32.

r Legt fest, ob anonyme Daten zum Nutzungsstatus dieser App erfasst werden dürfen

q

w

e

r
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Funktionen (Beschreibung des Displays)
 Fenster mit Akkordpalette
In diesem Fenster können Sie den Akkord festlegen, der bei der Wiedergabe des Styles verwendet werden soll.

q Gibt den Grundton des Akkords an.

w Gibt den Akkordtyp an.
Die Abkürzung „cc“ bedeutet „chord cancel“ (kein Akkord angegeben).

e Zum Aktivieren/Deaktivieren des Akkords mit abweichendem Basston und zum Festlegen der 
Bassnote.

r Zeigt den angegebenen Akkord an.

e

w

r

q
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Funktionen (Beschreibung des Displays)
 Fenster für die detaillierte Bearbeitung
In diesem Fenster können Sie die Einstellungen für den MIDI-Song-Kanal bearbeiten und detaillierte Einstellungen für jeden Part 
in der Style Section ändern.

q Steuert die MIDI-Song-Wiedergabe

w Legt die Ein/Aus-Einstellung (Stummschalten) jedes Kanals fest

e Setzt die MIDI-Kanaleinstellungen zurück
Stellt den Status vor der Bearbeitung zurück.

r Legt die Voice für jeden MIDI-Kanal fest
Dies können Sie durch Programmwechselnummern oder Voice-Namen angeben.

Die importierte Voice-Liste (Seite 5) wird für die Voice-Namenseinstellung verwendet.

Die Farben, die den Voice-Nummern oder Voice-Namen gegeben werden, zeigen die folgenden Zustände an.

t Legt die Lautstärke für jeden MIDI-Kanal fest

Weiß
Nicht bearbeitet und die Voice ändert sich während der 
Sequenz nicht.

Gelb
Nicht bearbeitet und die Voice ändert sich während der 
Sequenz.

Orange Die Voice wurde manuell festgelegt.

ew r q

io u t y
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Funktionen (Beschreibung des Displays)
y Zeigt den Lautstärkestatus für jeden MIDI-Kanal an
Die drei Typen für Lautstärkebedingungen werden folgendermaßen angezeigt.

u Setzt alle MIDI-Kanaleinstellungen zurück

i Zeigt den Zuordnungsstatus für jeden Kanal für die Section an und ruft detaillierte 
Einstellungen für Style-Parts auf
Zeigt die Part-Zuordnungen für jeden Kanal in jeder Section des Styles an.

Im Display werden die folgenden Abkürzungen verwendet.

Section-Name

Style-Part-Name

Durch Klicken auf jeden Style-Part-Namen können Sie detaillierte Parameter für die Parts in jeder Section bearbeiten.

Weitere Informationen zu detaillierten Parametern finden Sie auf Seite 33.

o Ändert die Part-Zuweisungen.
Sie können die Part-Zuweisungen für alle MIDI-Kanäle gleichzeitig ändern. Wenn Sie einen Part für den gewünschten Kanal 

angeben, wird dieser Kanal in allen Sections diesem Part zugewiesen.

Weiß
Nicht bearbeitet und die Lautstärke ändert sich während der 
Sequenz nicht.

Gelb
Nicht bearbeitet und die Lautstärke ändert sich während der 
Sequenz.

Orange Die Lautstärke wurde manuell festgelegt.

I1 bis 3 Intro I bis III

MA bis MD Main A bis D

FA bis FD Fill In A bis D

BK Break

E1 bis E3 Ending I bis III

R1, R2 Rhy1, Rhy2

Bs Bass

C1, C2 Chd1, Chd2

Pd Pad

P1, P2 Phr1, Phr2

HINWEIS
Da detaillierte Parameter anhand der Analyseergebnisse automatisch festgelegt werden, ist eine Bearbeitung normalerweise nicht 
notwendig.

HINWEIS
Wenn Sie dem Part in den verschiedenen Sections unterschiedliche Kanäle zuweisen möchten, ändern Sie die einzelnen 
Zuweisungen im Home-Display (Edit) (Seite 25).
16



Verwendung der App
Wiedergabe (Abspielen) des konvertierten Styles

Sie können beim Festlegen des Akkords ausprobieren, wie der konvertierte Style gespielt wird.

 Wiedergabe von Styles

1. Klicken Sie auf das Symbol für die Section, die Sie spielen möchten.

Das Section-Symbol wird als gespielt (hervorgehoben) angezeigt und die Section wird in einer Schleife abgespielt.

In diesem Beispiel wird Main B wiedergegeben.

Zudem wird standardmäßig das Fenster mit der Akkordpalette (Seite 14) automatisch aufgerufen.

2. Steuern Sie die Style-Wiedergabe, wie das Ändern von Sections und das Angeben von 
Akkorden.
• Wenn Sie auf das Symbol einer anderen Section klicken, wird diese Section abgespielt.

• Sie können die Änderung des Klangs beim Angeben des Akkords im Fenster mit der Akkordpalette oder über das 
Instrument prüfen, das als MIDI Input Device festgelegt wurde.

3. Klicken Sie auf das Symbol der gerade abgespielten Section, um die Style-Wiedergabe 
anzuhalten.

Legt die Ein/Aus-Einstellung für die Schleifenwiedergabe der Section fest.
Mit den Vorgabeeinstellungen dieser App wird jede Section in einer Schleife wiedergegeben, sodass Sie den Inhalt des Styles 
prüfen können. Dieses Verhalten unterscheidet sich von normalen Instrumenten mit Styles. Wenn Sie das Verhalten der 

normalerweise nicht in einer Schleife wiedergegebenen Sections (Intro I bis III, Fill In A bis D, Break und Ending I bis III) 

ändern möchten, sodass sie nicht in einer Schleife wiedergegeben werden, klicken Sie oben rechts neben dem Symbol auf die 
Markierung . Die Anzeige ändert sich zu  (Schleife Aus) und die betreffenden Sections werden nur einmal 

wiedergegeben. Anschließend wird wieder der Style gespielt – so wie es bei digitalen Keyboards mit Styles üblich ist.
17



Verwendung der App
 Ein-/Ausschalten jedes Style-Parts während der Wiedergabe
Sie können jeden Part im Home-Display (Edit) ein- bzw. ausschalten (stummschalten).

Klicken Sie auf den jeweiligen Style-Part-Namen, um den Part ein- bzw. auszuschalten.

Ausgeschaltete Parts werden ausgegraut dargestellt.

In diesem Beispiel sind Chd1 und Chd2 ausgeschaltet.
18



Verwendung der App
Speichern und Übertragen konvertierter Styles

Die Konvertierungsergebnisse können auf dem Computer gespeichert oder als Style-Datei (.sty) auf ein angeschlossenes 
Instrument übertragen werden.

1. Klicken Sie auf das Symbol .

2. Wählen Sie, wie die Datei gespeichert werden soll.
• [Save to Instrument]: Damit werden Style-Dateien direkt auf das Instrument übertragen und gespeichert.

Die Datei wird im Stammverzeichnis des User-Laufwerks gespeichert.

• [Save to Computer]: Damit werden Style-Dateien auf dem Computer gespeichert.

3. Folgen Sie zum Speichern oder Übertragen den Bildschirmanweisungen.
A) Für [Save to Instrument] (direkte Übertragung auf das Instrument)

Geben Sie einen Namen ein und klicken Sie auf [Save to Instrument], um die Übertragung zu starten.

B) Für [Save to Computer] (Speichern auf Computer)
Sobald das Dialogfenster zum Speichern der Datei angezeigt wird, geben Sie einen Namen ein und speichern Sie 

die Datei am gewünschten Speicherort.

Verwenden Sie zum Übertragen von Daten auf das Instrument ein USB-Flash-Laufwerk.

HINWEIS
Wenn Sie den Speichervorgang abbrechen möchten, klicken Sie erneut auf das Symbol .

HINWEIS
[Save to Instrument] kann nur verwendet werden, wenn der Computer über ein USB-Kabel mit dem Instrument verbunden ist. 
Anweisungen finden Sie auf Seite 3.
19



Verwendung der App
Ändern der Presets der automatischen Analyse

Die Analysebedingungen für MIDI-Songs werden automatisch festgelegt. Dies kann jedoch abhängig von den konkreten MIDI-
Daten zu unerwünschten Ergebnissen führen. Die Einstellung zum Ein- bzw. Ausschließen jedes Kanals von der Analyse kann 

geändert werden, sodass Sie die Daten erneut analysieren können, um die gewünschten Ergebnisse zu erhalten.

 Manuelles Festlegen von Kanälen, die von der Analyse ausgeschlossen werden 
sollen, und erneutes Analysieren

1. Stellen Sie das Home-Display auf den Edit-Modus.

2. Klicken Sie auf [Reanalyze Setting].

Das Display mit den Analyse-Einstellungen wird aufgerufen.

3. Legen Sie die Einstellungen zum Ausschließen von Kanälen wie gewünscht fest.

Bearbeiten Sie ggf. die Häkchen auf den Registerkarten [Melody] und [Assign].

• Registerkarte [Melody]: Die Kanäle mit einem Häkchen werden als „Hauptmelodie“ angesehen.
Anhand der Haupt-Melody-Kanäle wird der Section-Bereich eingeschätzt.

Wenn Sie auf der Registerkarte [Melody] ein Häkchen setzen, wird das Häkchen auf der Registerkarte [Assign] 

automatisch entfernt.
Die automatischen Identifikationsergebnisse der Hauptmelodie fließen in den Ausgangswert ein.

Setzen Sie bei den Kanälen ein Häkchen, die Sie als Hauptmelodie festlegen möchten (z. B. bei dem Kanal mit den 

Noten, die Sie spielen möchten).
• Registerkarte [Assign]: Kanäle mit einem Häkchen sind Parts, die Style-Parts zugeordnet werden können.

Wenn die Performance eines bestimmten Kanals im konvertierten Style nicht berücksichtigt werden soll, entfernen Sie 

das Häkchen.

4. Klicken Sie auf [Reanalyze], um die erneute Analyse durchzuführen.
Die Konvertierungsergebnisse werden aktualisiert.
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Verwendung der App
Bearbeiten des konvertierten Styles

Im Edit-Modus (Seite 11) des Home-Displays können Sie einen automatisch konvertierten Style nach Bedarf bearbeiten, um das 
gewünschte Konvertierungsergebnis zu erhalten.

 Ändern des Bereichs von Sections

1. Klicken Sie oben im Display auf den Section-Namen und wählen Sie die Section aus, deren 
Bereich Sie ändern möchten.

Die ausgewählte Section wird hervorgehoben. In diesem Beispiel wurde Intro II ausgewählt.

2. Ziehen Sie den rechten oder linken Rand des Section-Bereichs, um den Bereich wie 
gewünscht anzupassen.

Der Section-Bereich wurde geändert.

HINWEIS
Die in diesem Kapitel vorgestellten Bearbeitungsvorgänge können über [Edit] -> [Undo]/[Redo] im Menü oben in der App rückgängig 
gemacht und erneut ausgeführt werden.
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Verwendung der App
 Neuordnen von Sections
Wenn die Sections sich nach der automatischen Zuordnung nicht in der gewünschten Reihenfolge befinden, können Sie die 
Sections neu ordnen.

1. Klicken Sie oben im Display auf den Section-Namen, um die Section auszuwählen, deren 
Position Sie ändern möchten.

Die ausgewählte Section wird hervorgehoben. In diesem Beispiel wurde Main D ausgewählt.

2. Klicken Sie erneut auf den ausgewählten Section-Namen.

Das Popup für die Section-Zuordnung wird geöffnet.

3. Wählen Sie den Section-Namen für das neue Ziel aus und klicken Sie zur Bestätigung auf 
[Assign].

Die Section-Zuordnung wurde geändert. In diesem Beispiel wurde Main D durch Main A ersetzt.

HINWEIS
Sie können die Natürlichkeit erhalten, indem Sie die Main-Section und die Fill-In-Section zusammen ersetzen.

Sie können ein natürliches Gefühl bewahren, indem Sie die Main-Section und die Fill-In-Section zusammen ersetzen. Wenn Sie 
beispielsweise Main B durch Main C ersetzen, sollten Sie auch Fill B durch Fill C ersetzen, damit die Patterns einheitlich bleiben.
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Verwendung der App
 (Manuelles) Zuordnen einer neuen Section
Sie können einen gewünschten Bereich zum Zuordnen einer neuen Section festlegen.

1. Wählen Sie im Display den Bereich aus, dem die Section zugeordnet werden soll.

Der ausgewählte Bereich wird angezeigt.

2. Klicken Sie auf .

Das Popup für die Section-Zuordnung wird geöffnet.

3. Wählen Sie den Section-Namen aus, dem Sie den ausgewählten Bereich zuordnen möchten, 
und klicken Sie zur Bestätigung auf [Assign].
• Wenn Sie eine Section ohne bestehende Zuordnungen auswählen, wird eine neue Section hinzugefügt.
• Wenn Sie eine Section mit bestehenden Zuordnungen auswählen, wird die bestehende Section gelöscht und durch den 

neuen Bereich ersetzt.

In diesem Beispiel wird der ausgewählte Bereich als Intro I neu hinzugefügt.
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Verwendung der App
 Löschen von Sections
Sie können unnötige Sections löschen.

1. Klicken Sie mit der rechten Maustaste auf den zu löschenden Section-Namen.

Ein Löschen-Menü wird geöffnet.

2. Klicken Sie auf [Delete <Section name>].
Die Section wird gelöscht.
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Verwendung der App
 Ändern der Kombination aus Parts und MIDI-Kanälen in einer Section
Die Zuordnung, für die einzelne MIDI-Kanäle in bestimmte Style-Parts konvertiert werden, kann unabhängig von jeder Section 
geändert werden.

1. Klicken Sie oben im Display auf den Section-Namen, um die Section auszuwählen, die Sie 
bearbeiten möchten.

Der Kanal-Zuordnungsstatus für jeden Part in der ausgewählten Section wird angezeigt.

2. Ziehen und legen Sie den Part ab, dessen Zuordnung Sie ändern möchten.

Der Quell-Part und der Ziel-Part des Ziehvorgangs wurden ersetzt.

Entfernen oder Hinzufügen von Parts zu einer Section
Sie können eine Part-Zuordnung entfernen, indem Sie auf das [-]-Symbol neben dem Part-Namen klicken.

Ein [+]-Symbol wird für nicht zugeordnete Kanäle angezeigt, die im Bereich der Section Performance-Daten haben.

Durch Klicken auf das [+]-Symbol können Sie einen Section Part auswählen und zuordnen.

HINWEIS
Wenn Sie die Part-Zuweisungen zu den Kanälen für alle Sections zugleich zuweisen möchten, können Sie dies im Fenster für die 
Detaileinstellungen tun (Seite 15).
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Verwendung der App
 Ändern der Voice für jeden Kanal eines Songs (Detaillierte Bearbeitung)
Sie können von den allgemeinen, in einem MIDI-Song festgelegten Voices zu den hochwertigeren Voices wechseln, die für das 
Instrument einzigartig sind.

1. Wählen Sie [Edit] -> [Open DetailEdit Window] im Menü oben in der App.
Das Fenster für die detaillierte Bearbeitung wird aufgerufen.

2. Ändern Sie die Voice-Einstellungen für jeden Kanal.

Dies können Sie durch Programmwechselnummern oder Voice-Namen festlegen.

Die importierte Voice-Liste (Seite 5) wird für die Voice-Namenseinstellung verwendet.
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Verwendung der App
 Ändern/Zurücksetzen der Lautstärke für jeden Part eines Styles
Sie können die Lautstärke für jeden Style-Part in allen Sections ändern.

Die Lautstärke für jeden Part kann über die Regler unter den Style-Part-Namen eingestellt werden. Alternativ können Sie auch 

direkt die Werte bearbeiten.

Wenn Sie die geänderte Lautstärke auf die ursprüngliche Einstellung (als der MIDI-Song geladen wurde) zurücksetzen möchten, 

gehen Sie folgendermaßen vor:
• Wählen Sie im Menü oben in der App [Edit] -> [Reset Style Parameter] -> [Volume] und wählen Sie den Part aus, der 

zurückgesetzt werden soll.

• Halten Sie die Strg-Taste (Windows) bzw. die Command-Taste (Mac) gedrückt und klicken Sie auf den Regler für den 
entsprechenden Part, der zurückgesetzt werden soll.

Wenn Sie die vorherige Änderung rückgängig machen möchten, wählen Sie [Edit] -> [Undo].
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Verwendung der App
 Ändern des Beats (Taktmaßes) eines Styles
Sie können die Einstellung für den Beat (das Taktmaß) des Styles nach der Konvertierung ändern.
Klicken Sie unten im Display in den Bereich „Beat“ und legen Sie den Wert fest.

Die Bearbeitung der Taktmaß-Einstellungen kann zwischen allen Sections (Modus „All“) und einer einzelnen Section (Modus 

„Section“) umgeschaltet werden.

 Ändern des Style Section Key
Section key (Section Key Signature) ist ein Parameter, der anzeigt, auf welcher Tonart die Daten in jeder Section basieren.

Wenn Sie bei der Style-Wiedergabe Akkorde mit demselben Grundton wie diese Tonart angeben, werden die Intro- und 

Schlusssequenzen in derselben Tonhöhe wie der MIDI-Song vor der Konvertierung wiedergegeben. Wählen Sie oben im Display 
den zu ändernden Section-Namen aus und klicken Sie dann unten im Display auf den Bereich „Section Key“, um den Wert 

einzustellen.
28



Anhang
Terminologie

 MIDI-Songs (SMF)
• Elektronische Notenschrift-Daten. Wenn Sie solche Daten in ein kompatibles Gerät laden, können Sie Musik wiedergeben.

• Umfasst 16 „Kanäle“, mit denen Sie verschiedene Voices (Instrumentenklänge), die Lautstärke und den Performance-Inhalt 
einstellen können.

• SMF (Standard MIDI File) (.mid) ist der Name des Standardformats für MIDI-Dateien.

 Begriffe im Zusammenhang mit Style
Section:
Eine Gruppe musikalischer Daten (oder Pattern), mit denen ein Songs aufgebaut wird.

Beim Fortschreiten der Performance oder des Songs werden Sections automatisch oder manuell gewechselt.
Die Sections umfassen Intro I-III, Main A-D, Fill In A-D, Break und Ending I-III.

Beispiel:

Part:
Eine Komponente in einer Section. Voices usw. können für jeden Part einzeln festgelegt werden. Parts entsprechen Kanälen in 

einem MIDI-Song.
Die Parts umfassen Rhythm 1-2, Bass, Chord 1-2, Pad und Phrase 1-2.

Style-Datei: 
Style-File-Format (SFF) ist ein Format für die Begleitautomatik-Funktion (Style) von Yamaha.

Es gibt zwei Formate: SFF und SFF GE.

„SFF GE (Guitar Edition)“ ist eine Formaterweiterung zu SFF, welche die Ausdruckskraft von Gitarren-Voices verbessert.
MIDI Song to Style exportiert Style-Dateien im SFF GE-Format.

HINWEIS
Bei der automatischen Konvertierung in MIDI Song to Style werden einige Sections (Intro I, Break, Ending I, Ending III) nie zugeordnet. 
Daher ist es notwendig (und wünschenswert) diese Sections manuell zuzuordnen.

Vorgang

Style-Wiedergabe

INTRO
[I]

START/
STOP

MAIN
[B]

ENDING
[II]

Stop
Intro I

(einmal)
Main A

(Schleife)
Fill In B
(einmal)

Main B
(Schleife)

Ending II
(einmal)

Main A

Rhythm 1

Rhythm 2

Bass

Chord 1

Chord 2

Pad

Phrase 1

Phrase 2

Main B

Rhythm 1

Rhythm 2

Bass

Chord 1

Chord 2

Pad

Phrase 1

Phrase 2
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Anhang
Menü-Liste

* Bei der Mac-Version ist dieses Menü im Menü der App „MIDI Song to Style“ zu finden.

Menü Beschreibung

File

Open SMF Lädt MIDI-Song-Dateien (.mid,.midi).

Save Style File Speichert die konvertierte Style-Datei auf dem Computer.

Open Project
Lädt die Projektdatei (.sts) und reproduziert den Bearbeitungsstatus zum Zeitpunkt der 
Speicherung.

Save Project Speichert das bearbeitete Projekt im proprietären Format (.sts) in einer Projektdatei.

Recent Files Wählt zuletzt geöffnete Dateien aus.

Exit (Quit)* Beendet die App.

Edit

Undo Setzt den Bearbeitungsstatus auf den vorherigen Schritt zurück.

Redo
Nachdem Sie „Undo“ verwendet haben, wird der Bearbeitungsstatus einen Schritt vor-
wärts gesetzt.

Open DetailEdit Window Öffnet das Fenster für die detaillierte Bearbeitung.

Import Voice List

Importiert die Voice-Liste.

HINWEIS
Die Voice-Liste wird beim Einstellen der Voices im Fenster für die detaillierte 
Bearbeitung verwendet.

Reset Style Parameter Volume Setzt die Lautstärke für jeden Part eines Styles zurück.

Help

Manual Zeigt die Bedienungsanleitung (dieses Buch) an.

Privacy Statement Zeigt die Datenschutzerklärung an.

About* Zeigt die App-Version und das Copyright an.
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Anhang
Tastenkombinationen

Vorgang Tastenkombination

Laden einer MIDI-Song-Datei (.mid) Strg + Umschalt + O

Speichern einer Style-Datei (.sty) Strg + Umschalt + S

Laden einer Projektdatei (.sts) Strg + O

Speichern einer Projektdatei (.sts) Strg + S

Rückgängig machen Strg + Z

Wiederherstellen Strg + Umschalt + Z

Öffnen des Fensters für die detaillierte Bearbeitung Strg + Umschalt + D

Wiedergeben/Anhalten eines MIDI-Songs Leertaste

Wiedergabeposition eines MIDI-Songs: Um einen Takt weiterspringen . (Punkt)

Wiedergabeposition eines MIDI-Songs: Um einen Takt zurückspringen , (Komma)

Style starten/stoppen (aktuell gewählte Section) Umschalttaste + Leertaste

Klicken Sie auf [OK] Eingabetaste

Klicken Sie auf [Cancel] Esc-Taste

Das aktive separate Fenster schließen Strg-Taste + W

Home-Display (Edit): In der Übersicht der MIDI-Song-Daten hineinzoomen H

Home-Display (Edit): Aus der Übersicht der MIDI-Song-Daten herauszoomen G

HINWEIS
• Tastenkombinationen sind möglicherweise kurz nach der Eingabe von Zahlen auf der Tastatur nicht verfügbar. Wenn dies der Fall ist, 

klicken Sie im Display auf eine beliebige Stelle, um die Tastenkombinationen zu aktivieren.

• Beim Mac ersetzen Sie Strg durch Command.

• Tastenkombinationen funktionieren nur dann, wenn das entsprechende Fenster aktiv ist.
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Anhang
Meta-Event-Texte für die Angabe von Sections und Parts (Marker, Spurnamen)

Dies ist eine Tabelle der gültigen Strings (Zeichenketten), die bei der Angabe von Sections und Parts mittels Meta-Events in 
einem MIDI-Song von der App korrekt erkannt werden. Einen Überblick über alle Funktionen finden Sie im Display für weitere 

Einstellungen (Seite 13).

Angabe von Sections: Meta-Event 06 (Marker)
Der Bereich von einem gültigen Marker bis zum nächsten wird als Section angegeben.

Angabe von Parts: Meta-Event 03 (Sequence-/Spur-Name) oder 04 (Instrument-Name)
Wenn Spurname/Instrumentname eines Kanals mit einem der Namen der folgenden Tabelle übereinstimmt, wird der Kanal dem 

entsprechenden Part zugewiesen.

Section Text im Meta-Event

Intro I Intro i, Intro 1, Intro A

Intro II Intro ii, Intro 2, Intro B

Intro III Intro iii, Intro 3, Intro C

Main A Main A

Main B Main B

Main C Main C

Main D Main D

Fill In A Fill A

Fill In B Fill B

Fill In C Fill C

Fill In D Fill D

Break Break

Ending I Ending i, Ending 1, Ending A

Ending II Ending ii, Ending 2, Ending B

Ending III Ending iii, Ending 3, Ending C

End of Section End of Section, End, EOS

Part Text im Meta-Event

Rhythm 1 Rhythm1, Rhy1, AddDrum

Rhythm 2 Rhythm2, Rhy2, MainDrum

Bass Bass

Chord 1 Chord1, Chd1

Chord 2 Chord2, Chd2

Pad Pad

Phrase 1 Phrase1, Phr1

Phrase 2 Phrase2, Phr2

HINWEIS
Für den Text von Meta-Events können nur alphanumerische Zeichen (ASCII-Zeichensatz) verwendet werden. 

Wenn Zwei-Byte-Zeichen verwendet werden, wird der Text unlesbar und nicht korrekt erkannt.
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Anhang
Fenster zur detaillierten Bearbeitung: Bearbeiten von Section-
Parametern

Das Bearbeitungsfenster für Section-Parameter wird aufgerufen, wenn Sie im Fenster für die detaillierte Bearbeitung auf einen 
Part in einer Section klicken (Seite 15).
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Anhang
 Beschreibungen für jedes Element im Display

Name des Elements Beschreibung

Section Setting Schaltet die Section in den Bearbeitungsmodus.
Nur bei diesem Element unterscheidet sich der Section-Name von der normalen 
Anzeige. Ersetzen Sie Section-Namen durch folgende:
• Intro A-C: Intro I-III
• Fill In AA-DD: Fill In A-D
• Fill In BA: Break
• Ending A-C: Ending I-III

Key Signature Legt die Section Key Signature fest.

Channel Setting Schaltet den MIDI-Kanal auf Bearbeitung, sodass er in der ausgewählten 
Section bearbeitet werden kann.

Attribute Zeigt Kanalattribute (automatische Analyseergebnisse) an.

Style Part Zeigt die Part-Zuordnung des ausgewählten Kanals in einer Section an.

Zone Setting Unterteilt den Bereich und legt den Betrieb für die obigen Kanäle (den Kanälen 
zugeordnete Style-Parts) in einem Section-Bereich fest.

Lo Zone Split Bestimmt, wo die Lo Zone und die Main Zone geteilt werden sollen.
Geben Sie den niedrigsten Tonartwert (-, 1 bis 127) der Main Zone ein.
Wenn der Wert „-“ ist, werden die Einstellungen in der Lo Zone deaktiviert.

Style Playing 
Parameter

Zeigt den Style Playing Parameter für die Lo Zone (automatische Einstellung 
und Bearbeitung sind nicht erlaubt) an.

Convert to Style 
Parameter

Legt die Regeln für die Notenumwandlung für die Lo Zone bei der Konvertierung 
in einen Style fest.
Es gibt vier Optionen : Root only, Active for Main, Semi-active Bass und -.

HiKey
(High Key)

Bestimmt den Standardwert (0 bis 11: C bis B) zum Umschalten zwischen 
Transponierung nach oben oder nach unten während der Style-Wiedergabe für 
die Lo Zone.
Wenn bei der Wiedergabe eine Note als Akkordgrundton angegeben wird, die 
höher als dieser Wert ist, erfolgt die Transponierung nach unten.

LoLim
(Low Limit)

Bestimmt den minimalen Transpositionswert (0 bis 127) während der Style-
Wiedergabe für die Lo Zone.
Wenn das Ergebnis der Tanspositionsberechnung eine Zahl kleiner als dieser 
Wert während der Wiedergabe ist, werden Aktionen wie Oktavierung oder 
Klangstopp gemäß Style Playing Parameter durchgeführt.

HiLim
(High Limit)

Bestimmt den maximalen Transpositionswert (0 bis 127) während der Style-
Wiedergabe für die Lo Zone.
Wenn das Ergebnis der Tanspositionsberechnung eine Zahl größer als dieser 
Wert während der Wiedergabe ist, werden Aktionen wie Oktavierung oder 
Klangstopp gemäß Style Playing Parameter durchgeführt.
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Anhang
Zone Setting Main Zone Style Playing 
Parameter

Legt den Style Playing Parameter für die Main Zone fest.

Convert to Style 
Parameter

Legt die Regeln für die Notenumwandlung für die Main Zone bei der 
Konvertierung in einen Style fest.

HiKey 
(High Key)

Bestimmt den Standardwert (0 bis 11: C bis B) zum Umschalten zwischen 
Transponierung nach oben oder nach unten während der Style-Wiedergabe für 
die Main Zone.
Wenn bei der Wiedergabe eine Note als Akkordgrundton angegeben wird, die 
höher als dieser Wert ist, erfolgt die Transponierung nach unten.

LoLim 
(Low Limit)

Bestimmt den minimalen Transpositionswert (0 bis 127) während der Style-
Wiedergabe für die Main Zone.
Wenn das Ergebnis der Tanspositionsberechnung eine Zahl kleiner als dieser 
Wert während der Wiedergabe ist, werden Aktionen wie Oktavierung oder 
Klangstopp gemäß Style Playing Parameter durchgeführt.

HiLim 
(High Limit)

Bestimmt den maximalen Transpositionswert (0 bis 127) während der Style-
Wiedergabe für die Main Zone.
Wenn das Ergebnis der Tanspositionsberechnung eine Zahl größer als dieser 
Wert während der Wiedergabe ist, werden Aktionen wie Oktavierung oder 
Klangstopp gemäß Style Playing Parameter durchgeführt.

Hi Zone Mega Voice Legt fest, ob bei Noten in der Hi Zone (C6 oder höher) MegaVoice-Effekte 
angewendet werden sollen.
Bei Aktivierung werden bei Verwendung von MegaVoice Noten ab C6 nicht 
umgewandelt und weiterhin korrekt gespielt.

Name des Elements Beschreibung
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Anhang
 Informationen zu Style Playing Parameter
Es gibt Regeln für die Notenumwandlung, bei denen jeder Part einer Section während der Style-Wiedergabe eine zugehörige 
Akkordspezifikation haben darf.

Durch Auswählen von Presets, die den Eigenschaften jedes Parts entsprechen, wird die Qualität und Genauigkeit Ihres Spiels 

sichergestellt.

 Informationen zu Convert to Style Parameter
Dies sind die Regeln für die Umwandlung von Noten in Kanälen zu Noten in Style-Parts.

Preset-Name Beschreibung

Bass Für den Bass-Part der Main/Fill-Section

Bass (Intro) Für den Bass-Part der Intro/Ending-Section

Chord Für einen Part, der hauptsächlich aus Akkorden mit mehreren Noten der Main/Fill-Section besteht

Phrase chordal
Für einen Part, der hauptsächlich aus gebrochenen Akkorden (Arpeggios usw.) mit einer Note der Main/Fill-
Section besteht

Phrase melodic Für einen Part, der hauptsächlich aus melodischen Phrasen mit einer Note der Main/Fill-Section besteht

Guitar Stroke
Für einen Part, der eine Gitarren-Voice verwendet und hauptsächlich aus Akkorden (Akkordanschläge usw.) 
mit mehreren Noten der Main/Fill-Section besteht

Guitar Arpeggio
Für einen Part, der eine Gitarren-Voice verwendet und hauptsächlich aus gebrochenen Akkorden (Arpeggios 
usw.) mit einer Note der Main/Fill-Section besteht

Chromatic Für einen Part, der hauptsächlich aus chromatischen Tonleiterphrasen der Main/Fill-Section besteht.

Maj-min (Intro) Für einen anderen Part als Bass und Phr1-2 oder Intro/Ending-Section

Drum with cymbal Für einen Part, der ein Schlagzeug-Set mit Crash-Becken verwendet

Drum no cymbal Für einen Part, der ein Schlagzeug-Set ohne Crash-Becken verwendet

SFX Für einen Part, der ein SFX-Kit verwendet

- Keine Zuordnung (wenn es keine Part-Zuordnung gibt)

HINWEIS
Auf Bass (Intro) oder Maj-min (Intro) eingestellte Parts werden stark von der Section-Tonart dieses Parts beeinflusst.

Preset-Name Beschreibung

no change Die Noten werden nicht geändert.

Root only Nur der Akkordgrundton wird reproduziert.

Root & 5th Nur der Akkordgrundton und die reine Quinte werden reproduziert.

Semi-active Bass

Die ursprüngliche Performance wird mit einigen möglichen 
Einschränkungen reproduziert. Die Zuverlässigkeit und Richtigkeit 
beim Angeben von Akkorden während der Style-Wiedergabe kann 
schlechter als „Root Only“ sein.

Stable for Main

Die zuverlässige Wiedergabe von Akkorden mit mehreren Noten ist 
bei bestimmten Akkorden während der Style-Wiedergabe möglich.
Die ursprüngliche Performance wird jedoch möglicherweise nicht 
genau reproduziert.

Active for Main

Wenn die Ergebnisse der Akkordanalyse während der Analyse richtig 
sind, wird die ursprüngliche Performance genau reproduziert. Wenn 
die Ergebnisse der Akkordanalyse Fehler enthält, ist der konvertierte 
Style möglicherweise musikalisch ungeeignet.

Guitar Stroke Einstellungen speziell für „Guitar Stroke“

Guitar Arpeggio Einstellungen speziell für „Guitar Arpeggio“
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Anhang
 Einschränkungen der Optionen für Convert to Style Parameter
Die Optionen für Convert to Style Parameter ändern sich abhängig von den Einstellungen für Style Playing Parameter (siehe 
Tabelle unten).

Style Playing Parameter

Bass
Bass 
(Intro)

Chord
Phrase 
chordal

Phrase 
melodic

Guitar 
Stroke

Guitar 
Arpeggio

Chromatic, 
Maj-min (Intro), 
Drums with cymbals, 
Drums without 
cymbals, SFX

Convert to Style 
Parameter 

no change  

Root only   

Root & 5th  

Semi-active 
Bass



Stable for 
Main

  

Active for 
Main

   

Active root 
only

 

Active root & 
5th

 

Guitar Stroke 

Guitar 
Arpeggio


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Anhang
Fehlerbehebung

Wenn die App nicht normal funktioniert, überprüfen Sie die folgenden Punkte, um festzustellen, ob das Problem mit diesen 
einfachen Maßnahmen gelöst werden kann.

Problem Mögliche Ursachen Lösungen

Dateien können nicht auf dem Instrument 
gespeichert (auf das Instrument übertragen) 
werden, obwohl die App mit dem Instrument 
verbunden ist.

Für kein Instrument ist MIDI Input Device 
und/oder MIDI Output Device eingestellt.

Stellen Sie sicher, dass für das 
angeschlossene Instrument MIDI Input 
Device und MIDI Output Device in der 
Einstellung korrekt eingestellt ist.

Akkorde können vom Instrument während 
der Style-Vorschau nicht angegeben 
werden, obwohl die App mit dem Instrument 
verbunden ist.

Am Instrument ist [ACMP] aktiviert. Wenn 
die Funktion [ACMP] aktiviert ist, werden 
Akkordinformationen nur an das Instrument, 
nicht aber an den Computer gesendet.

Deaktivieren Sie [ACMP] am Instrument.

Das App-Display wird schwarz. Das Fenster ist maximiert. Wenn Sie die App 
mit maximiertem Fenster verwenden, kann 
dies das Display anderer Fenster durch 
Betriebssystemprozesse stören.

• Drücken Sie die [ESC]-Taste, um die 
Maximierung des Fensters aufzuheben.

• Verwenden Sie die App, ohne das Fenster 
zu maximieren.
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